Modicon M580
Change Configuration on the Fly
User Guide

(Original Document)

12/2018
The information provided in this documentation contains general descriptions and/or technical characteristics of the performance of the products contained herein. This documentation is not intended as a substitute for and is not to be used for determining suitability or reliability of these products for specific user applications. It is the duty of any such user or integrator to perform the appropriate and complete risk analysis, evaluation and testing of the products with respect to the relevant specific application or use thereof. Neither Schneider Electric nor any of its affiliates or subsidiaries shall be responsible or liable for misuse of the information contained herein. If you have any suggestions for improvements or amendments or have found errors in this publication, please notify us.

You agree not to reproduce, other than for your own personal, noncommercial use, all or part of this document on any medium whatsoever without permission of Schneider Electric, given in writing. You also agree not to establish any hypertext links to this document or its content. Schneider Electric does not grant any right or license for the personal and noncommercial use of the document or its content, except for a non-exclusive license to consult it on an “as is” basis, at your own risk. All other rights are reserved.

All pertinent state, regional, and local safety regulations must be observed when installing and using this product. For reasons of safety and to help ensure compliance with documented system data, only the manufacturer should perform repairs to components.

When devices are used for applications with technical safety requirements, the relevant instructions must be followed.

Failure to use Schneider Electric software or approved software with our hardware products may result in injury, harm, or improper operating results.

Failure to observe this information can result in injury or equipment damage.

© 2018 Schneider Electric. All rights reserved.
# Table of Contents

<table>
<thead>
<tr>
<th>Part</th>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safety Information</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>About the Book</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>Part I</td>
<td>Introduction to M580 Change Configuration on the Fly</td>
<td>15</td>
</tr>
<tr>
<td>Chapter 1</td>
<td>Introduction to M580 CCOTF</td>
<td>17</td>
</tr>
<tr>
<td>CCOTF Guidelines</td>
<td>18</td>
<td></td>
</tr>
<tr>
<td>CCOTF Types</td>
<td>19</td>
<td></td>
</tr>
<tr>
<td>CCOTF Parameters: What Can I Change?</td>
<td>23</td>
<td></td>
</tr>
<tr>
<td>CCOTF Counting and Status</td>
<td>26</td>
<td></td>
</tr>
<tr>
<td>Chapter 2</td>
<td>Prerequisites for M580 CCOTF</td>
<td>29</td>
</tr>
<tr>
<td>CCOTF Hardware Compatibility</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>CCOTF Hot Standby Guidelines</td>
<td>32</td>
<td></td>
</tr>
<tr>
<td>CCOTF Settings</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>Part II</td>
<td>How to Perform an M580 CCOTF Modification</td>
<td>37</td>
</tr>
<tr>
<td>Chapter 3</td>
<td>Adding an RIO Drop using CCOTF</td>
<td>39</td>
</tr>
<tr>
<td>Adding an RIO Drop Using the Standard Connected Mode</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>Adding an RIO Drop Using the Virtual Connected Mode</td>
<td>42</td>
<td></td>
</tr>
<tr>
<td>Chapter 4</td>
<td>Adding / Deleting Modules in Local Racks and RIO Drops Using CCOTF</td>
<td>45</td>
</tr>
<tr>
<td>Adding/Deleting a Module in a Local Rack</td>
<td>46</td>
<td></td>
</tr>
<tr>
<td>Adding/Deleting a Module in an RIO Drop Using the Standard Connected Mode</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>Adding/Deleting a Module in an RIO Drop Using the Virtual Connected Mode</td>
<td>54</td>
<td></td>
</tr>
<tr>
<td>Chapter 5</td>
<td>Modifying Module Parameters</td>
<td>57</td>
</tr>
<tr>
<td>Modifying Module Parameters Using the Standard Connected Mode</td>
<td>58</td>
<td></td>
</tr>
<tr>
<td>Modifying Module Parameters Using the Virtual Connected Mode</td>
<td>59</td>
<td></td>
</tr>
<tr>
<td>Glossary</td>
<td>61</td>
<td></td>
</tr>
<tr>
<td>Index</td>
<td>65</td>
<td></td>
</tr>
</tbody>
</table>
Important Information

NOTICE

Read these instructions carefully, and look at the equipment to become familiar with the device before trying to install, operate, service, or maintain it. The following special messages may appear throughout this documentation or on the equipment to warn of potential hazards or to call attention to information that clarifies or simplifies a procedure.

⚠️ The addition of this symbol to a "Danger" or "Warning" safety label indicates that an electrical hazard exists which will result in personal injury if the instructions are not followed.

⚠️ This is the safety alert symbol. It is used to alert you to potential personal injury hazards. Obey all safety messages that follow this symbol to avoid possible injury or death.

⚠️ DANGER

DANGER indicates a hazardous situation which, if not avoided, will result in death or serious injury.

⚠️ WARNING

WARNING indicates a hazardous situation which, if not avoided, could result in death or serious injury.

⚠️ CAUTION

CAUTION indicates a hazardous situation which, if not avoided, could result in minor or moderate injury.

⚠️ NOTICE

NOTICE is used to address practices not related to physical injury.
PLEASE NOTE

Electrical equipment should be installed, operated, serviced, and maintained only by qualified personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction and operation of electrical equipment and its installation, and has received safety training to recognize and avoid the hazards involved.

BEFORE YOU BEGIN

Do not use this product on machinery lacking effective point-of-operation guarding. Lack of effective point-of-operation guarding on a machine can result in serious injury to the operator of that machine.

⚠️ WARNING

UNGUARDED EQUIPMENT

- Do not use this software and related automation equipment on equipment which does not have point-of-operation protection.
- Do not reach into machinery during operation.

Failure to follow these instructions can result in death, serious injury, or equipment damage.

This automation equipment and related software is used to control a variety of industrial processes. The type or model of automation equipment suitable for each application will vary depending on factors such as the control function required, degree of protection required, production methods, unusual conditions, government regulations, etc. In some applications, more than one processor may be required, as when backup redundancy is needed.

Only you, the user, machine builder or system integrator can be aware of all the conditions and factors present during setup, operation, and maintenance of the machine and, therefore, can determine the automation equipment and the related safeties and interlocks which can be properly used. When selecting automation and control equipment and related software for a particular application, you should refer to the applicable local and national standards and regulations. The National Safety Council's Accident Prevention Manual (nationally recognized in the United States of America) also provides much useful information.

In some applications, such as packaging machinery, additional operator protection such as point-of-operation guarding must be provided. This is necessary if the operator's hands and other parts of the body are free to enter the pinch points or other hazardous areas and serious injury can occur. Software products alone cannot protect an operator from injury. For this reason the software cannot be substituted for or take the place of point-of-operation protection.
Ensure that appropriate safeties and mechanical/electrical interlocks related to point-of-operation protection have been installed and are operational before placing the equipment into service. All interlocks and safeties related to point-of-operation protection must be coordinated with the related automation equipment and software programming.

NOTE: Coordination of safeties and mechanical/electrical interlocks for point-of-operation protection is outside the scope of the Function Block Library, System User Guide, or other implementation referenced in this documentation.

**START-UP AND TEST**

Before using electrical control and automation equipment for regular operation after installation, the system should be given a start-up test by qualified personnel to verify correct operation of the equipment. It is important that arrangements for such a check be made and that enough time is allowed to perform complete and satisfactory testing.

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>EQUIPMENT OPERATION HAZARD</strong></td>
</tr>
<tr>
<td>● Verify that all installation and set up procedures have been completed.</td>
</tr>
<tr>
<td>● Before operational tests are performed, remove all blocks or other temporary holding means used for shipment from all component devices.</td>
</tr>
<tr>
<td>● Remove tools, meters, and debris from equipment.</td>
</tr>
</tbody>
</table>

*Failure to follow these instructions can result in death, serious injury, or equipment damage.*

Follow all start-up tests recommended in the equipment documentation. Store all equipment documentation for future references.

**Software testing must be done in both simulated and real environments.**

Verify that the completed system is free from all short circuits and temporary grounds that are not installed according to local regulations (according to the National Electrical Code in the U.S.A, for instance). If high-potential voltage testing is necessary, follow recommendations in equipment documentation to prevent accidental equipment damage.

Before energizing equipment:
| ● Remove tools, meters, and debris from equipment. |
| ● Close the equipment enclosure door. |
| ● Remove all temporary grounds from incoming power lines. |
| ● Perform all start-up tests recommended by the manufacturer. |
OPERATION AND ADJUSTMENTS

The following precautions are from the NEMA Standards Publication ICS 7.1-1995 (English version prevails):

- Regardless of the care exercised in the design and manufacture of equipment or in the selection and ratings of components, there are hazards that can be encountered if such equipment is improperly operated.
- It is sometimes possible to misadjust the equipment and thus produce unsatisfactory or unsafe operation. Always use the manufacturer’s instructions as a guide for functional adjustments. Personnel who have access to these adjustments should be familiar with the equipment manufacturer’s instructions and the machinery used with the electrical equipment.
- Only those operational adjustments actually required by the operator should be accessible to the operator. Access to other controls should be restricted to prevent unauthorized changes in operating characteristics.
About the Book

At a Glance

Document Scope
This guide provides information about the Change Configuration on the Fly (CCOTF) feature in a M580 system, using Control Expert software.

NOTE: The specific configuration settings contained in this guide are intended to be used for instructional purposes only. The settings required for your specific configuration may differ from the examples presented in this guide.

Validity Note
This document is valid for an M580 system when used with EcoStruxure™ Control Expert 14.0 or later.

In addition to the CCOTF transactions in Unity Pro 10.0 or earlier, you can perform these transactions in Unity Pro 11.0 or later, which are described in this guide:

<table>
<thead>
<tr>
<th>M580 System Location</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>local rack</td>
<td>all M580 CPUs, except BMEH58•040 Hot Standby CPUs with Ethernet I/O scanning service (both RIO and DIO scanning)</td>
</tr>
<tr>
<td>Reminder: M580 Hot Standby systems do not support local I/O modules on the local rack</td>
<td></td>
</tr>
<tr>
<td>(e)X80 RIO drop (with a BM•CRA312•0 eX80 performance EIO adapter module)</td>
<td>BME•58•040 CPUs with Ethernet I/O scanner service</td>
</tr>
<tr>
<td>Quantum RIO drop (with a 140CRA31200 RIO adapter module)</td>
<td></td>
</tr>
</tbody>
</table>

**standalone**

- BMEP584040
- BMEP585040
- BMEP586040

**Hot Standby**

all CPUs, except BME H58 2040

**NOTE:** Unity Pro is the former name of Control Expert for version 13.1 or earlier.
The technical characteristics of the devices described in the present document also appear online. To access the information online:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Go to the Schneider Electric home page <a href="http://www.schneider-electric.com">www.schneider-electric.com</a>.</td>
</tr>
</tbody>
</table>
| 2    | In the **Search** box type the reference of a product or the name of a product range.  
  ● Do not include blank spaces in the reference or product range.  
  ● To get information on grouping similar modules, use asterisks (*). |
| 3    | If you entered a reference, go to the **Product Datasheets** search results and click on the reference that interests you.  
  If you entered the name of a product range, go to the **Product Ranges** search results and click on the product range that interests you. |
| 4    | If more than one reference appears in the **Products** search results, click on the reference that interests you. |
| 5    | Depending on the size of your screen, you may need to scroll down to see the data sheet. |
| 6    | To save or print a data sheet as a .pdf file, click **Download XXX product datasheet**. |

The characteristics that are presented in the present document should be the same as those characteristics that appear online. In line with our policy of constant improvement, we may revise content over time to improve clarity and accuracy. If you see a difference between the document and online information, use the online information as your reference.

**Related Documents**

<table>
<thead>
<tr>
<th>Title of Documentation</th>
<th>Reference Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modicon M580 BMENOC0301/11 Ethernet Module Installation and Configuration Guide</td>
<td>HRB62665 (English), HRB65311 (French), HRB65313 (German), HRB65314 (Italian), HRB65315 (Spanish), HRB65316 (Chinese)</td>
</tr>
<tr>
<td>Modicon M580 Remote I/O Modules Installation and Configuration Guide</td>
<td>EIO00000001578 (English), EIO00000001579 (French), EIO00000001580 (German), EIO00000001582 (Italian), EIO00000001581 (Spanish), EIO00000001583 (Chinese)</td>
</tr>
<tr>
<td>Modicon M580 Hardware Reference Manual</td>
<td>EIO00000001578 (English), EIO00000001579 (French), EIO00000001580 (German), EIO00000001582 (Italian), EIO00000001581 (Spanish), EIO00000001583 (Chinese)</td>
</tr>
<tr>
<td>Title of Documentation</td>
<td>Reference Number</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Modicon M580 Standalone System Planning Guide for Frequently Used Architectures</td>
<td>HRB62666 (English), HRB65318 (French), HRB65319 (German), HRB65320 (Italian),</td>
</tr>
<tr>
<td></td>
<td>HRB65321 (Spanish), HRB65322 (Chinese)</td>
</tr>
<tr>
<td>Modicon M580 System Planning Guide for Complex Topologies</td>
<td>NHA58892 (English), NHA58893 (French), NHA58894 (German), NHA58895 (Italian),</td>
</tr>
<tr>
<td></td>
<td>NHA58896 (Spanish), NHA58897 (Chinese)</td>
</tr>
<tr>
<td>Modicon M580, M340, and X80 I/O Platforms, Standards and Certifications</td>
<td>EI00000002726 (English), EI00000002727 (French), EI00000002728 (German),</td>
</tr>
<tr>
<td></td>
<td>EI00000002730 (Italian), EI00000002729 (Spanish), EI00000002731 (Chinese)</td>
</tr>
<tr>
<td>Modicon M580 BMENOS0300 Network Option Switch Module Installation and Configuration</td>
<td>NHA89117 (English), NHA89119 (French), NHA89120 (German), NHA89121 (Italian),</td>
</tr>
<tr>
<td>Guide</td>
<td>NHA89122 (Spanish), NHA89123 (Chinese)</td>
</tr>
<tr>
<td>Modicon M580 Hot Standby System Planning Guide for Frequently Used Architectures</td>
<td>NHA58880 (English), NHA58881 (French), NHA58882 (German), NHA58883 (Italian),</td>
</tr>
<tr>
<td></td>
<td>NHA58884 (Spanish), NHA58885 (Chinese)</td>
</tr>
<tr>
<td>Modicon M340/X80 BMXNRP0200/0201 Fiber Converter Module User Guide</td>
<td>EI00000001108 (English), EI00000001110 (German), EI00000001109 (French),</td>
</tr>
<tr>
<td></td>
<td>EI00000001111 (Spanish), EI00000001112 (Italian), EI00000001113 (Chinese)</td>
</tr>
<tr>
<td>Modicon X80 with EcoStruxure™ Control Expert HART Analog Input/Output Modules User</td>
<td>EAV16400 (English), EAV28404 (French), EAV28384 (German), EAV28360 (Spanish),</td>
</tr>
<tr>
<td>Manual</td>
<td>EAV28413 (Italian), EAV28417 (Chinese)</td>
</tr>
<tr>
<td>Title of Documentation</td>
<td>Reference Number</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>Modicon M340/ X80 with EcoStruxure™ Control Expert Analog Input/Output Modules User Manual</td>
<td>35011978 (English), 35011980 (French), 35011979 (German), 35011981 (Spanish), 35011982 (Italian), 35011983 (Chinese)</td>
</tr>
<tr>
<td>Modicon M340/ X80 with EcoStruxure™ Control Expert Discrete Input/Output Modules User Manual</td>
<td>35012474 (English), 35012476 (French), 35012475 (German), 35012477 (Spanish), 35012478 (Italian), 35012479 (Chinese)</td>
</tr>
<tr>
<td>Modicon M340/ X80 with EcoStruxure™ Control Expert BMXEHC0200 Counting Modules User Manual</td>
<td>35013355 (English), 35013357 (French), 35013356 (German), 35013358 (Spanish), 35013359 (Italian), 35013360 (Chinese)</td>
</tr>
<tr>
<td>EcoStruxure™ Control Expert Operating Modes</td>
<td>33003101 (English), 33003102 (French), 33003103 (German), 33003104 (Spanish), 33003696 (Italian), 33003697 (Chinese)</td>
</tr>
<tr>
<td>EcoStruxure™ Control Expert Installation Manual</td>
<td>35014793 (English), 35014792 (French), 35014794 (German), 35014795 (Spanish), 35014796 (Italian), 35012191 (Chinese)</td>
</tr>
</tbody>
</table>
You can download these technical publications and other technical information from our website at https://www.schneider-electric.com/en/download

<table>
<thead>
<tr>
<th>Title of Documentation</th>
<th>Reference Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>EcoStruxure™ Control Expert Program Languages and Structure</td>
<td>35006144 (English), 35006145 (French),</td>
</tr>
<tr>
<td>Reference Manual</td>
<td>35006146 (German), 35006147 (Spanish),</td>
</tr>
<tr>
<td></td>
<td>35013361 (Italian), 35013362 (Chinese)</td>
</tr>
<tr>
<td>EcoStruxure™ Control Expert, System Bits and Words, Reference</td>
<td>EIO0000002135 (English), EIO0000002136</td>
</tr>
<tr>
<td>Manual</td>
<td>(French), EIO0000002137 (German), EIO0000002138 (Italian), EIO0000002139 (Spanish), EIO0000002140 (Chinese)</td>
</tr>
</tbody>
</table>
Part I
Introduction to M580 Change Configuration on the Fly

Introduction
CCOTF allows you to modify the PAC hardware configuration and parameters while the PAC is running without impacting other modules or ongoing tasks in the system. This part describes the CCOTF feature for M580 modules using Control Expert software.

In addition to the CCOTF transactions in Unity Pro 10.0 or earlier, you can perform these transactions in Unity Pro 11.0 or later, which are described in this guide:

<table>
<thead>
<tr>
<th>M580 System Location</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>local rack</td>
<td>all M580 CPUs, except BME H58 4040 Hot Standby CPUs with Ethernet I/O scanning service (both RIO and DIO scanning)</td>
</tr>
<tr>
<td></td>
<td>Reminder: M580 Hot Standby systems do not support local I/O modules on the local rack</td>
</tr>
<tr>
<td>(e)X80 RIO drop (with a BM•CRA31210 eX80 performance EIO adapter module)</td>
<td>BME•58•040 CPUs with Ethernet I/O scanner service</td>
</tr>
</tbody>
</table>
| Quantum RIO drop (with a 140CRA31200 RIO adapter module) | • BMEP584040  
  • BMEP585040  
  • BMEP586040 |
| standalone           | all CPUs, except BMEH582040 |
| Hot Standby         |          |

NOTE: Unity Pro is the former name of Control Expert for version 13.1 or earlier.

What Is in This Part?
This part contains the following chapters:

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Chapter Name</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Introduction to M580 CCOTF</td>
<td>17</td>
</tr>
<tr>
<td>2</td>
<td>Prerequisites for M580 CCOTF</td>
<td>29</td>
</tr>
</tbody>
</table>
Chapter 1
Introduction to M580 CCOTF

Introduction

When you perform CCOTF on a local or remote drop (example: add / delete a module), the change does not affect any other drop in the configuration. In Control Expert, CCOTF is called a configuration online modification in RUN mode, and is part of online action. You can perform other changes using Tools → PLC Screen, such as cold start, warm start, etc. (Refer to the CPU debugging screen (see EcoStruxure™ Control Expert, Operating Modes).) This chapter details CCOTF capabilities and how modules execute a CCOTF request.

What Is in This Chapter?

This chapter contains the following topics:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCOTF Guidelines</td>
<td>18</td>
</tr>
<tr>
<td>CCOTF Types</td>
<td>19</td>
</tr>
<tr>
<td>CCOTF Parameters: What Can I Change?</td>
<td>23</td>
</tr>
<tr>
<td>CCOTF Counting and Status</td>
<td>26</td>
</tr>
</tbody>
</table>
CCOTF Guidelines

Recommendations

Follow these recommendations before performing a CCOTF modification.

**NOTE:** Read and understand the preventive measures that are described in the chapter *Electric Shock: Causes and preventive measures* (see *Grounding and Electromagnetic Compatibility of PLC Systems, Basic Principles and Measures, User Manual*).

**DANGER**

HAZARD OF ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH

Do not handle a module that has a voltage level of 30 Vrms or 42.4 Vdc or higher.

Failure to follow these instructions will result in death or serious injury.

**WARNING**

UNEXPECTED EQUIPMENT BEHAVIOR

- Before performing any CCOTF, verify that your system responds appropriately.
- Modifications made when the **Online modification in RUN or STOP** check box is selected in Control Expert have an immediate impact on the system.

Failure to follow these instructions can result in death, serious injury, or equipment damage.

In Control Expert, you can configure your project to allow online modifications by double-clicking the CPU in the **PLC bus** (or right-click **Open Module**), selecting the **Configuration** tab, and selecting the **Online modification in RUN or STOP** check box. When this check box is selected, any modifications you make may have an immediate impact on the system.
CCOTF Types

Introduction

You can perform several types of CCOTF modifications on the local rack or an RIO drop. The types of modifications include adding/deleting modules, modifying module parameters, and adding an RIO drop.

NOTE: Use an M580 CPU version 2.00 (or later) to manage local I/O CCOTF features.

One or more CCOTF modifications comprise a single transaction in Control Expert. A CCOTF transaction executes when you select Build → Build Changes.

Confirm that all CCOTF modifications in a transaction are the same type of modification. For example, you cannot add a module and delete a module in an RIO drop.

Confirm that all adding module modifications or deleting module modifications in a single transaction are associated with one task type (MAST, FAST, AUX0 or AUX1).

Refer to the Modicon M580 Remote I/O Modules Installation and Configuration Guide (see Modicon M580, RIO Modules, Installation and Configuration Guide) and the Modicon M580 Hardware Reference Manual (see Modicon M580, Hardware, Reference Manual) regarding the types of tasks that are allowed in local and RIO drops.
Limitations

This table describes the limitations for CCOTF and online changes (see EcoStruxure™ Control Expert, Operating Modes):

<table>
<thead>
<tr>
<th>If you want to... ↓</th>
<th>Local Racks (Main or Extended)</th>
<th>RIO Drop</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>IODDT</td>
<td>Device DDT</td>
</tr>
<tr>
<td>add/delete a power supply module</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>add/delete a digital/analog module(8)</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>add/delete a motion module</td>
<td>–</td>
<td>N</td>
</tr>
<tr>
<td>add/delete a third-party module</td>
<td>–</td>
<td>N</td>
</tr>
<tr>
<td>add/delete an X Bus/Ethernet communication module</td>
<td>–</td>
<td>N</td>
</tr>
<tr>
<td>add/delete an extended rack</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>add an RIO drop</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>delete an RIO drop</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>modify module configuration parameters</td>
<td>online change(5)(7)</td>
<td>online change(1)(5)</td>
</tr>
<tr>
<td>modify counter adjust parameters</td>
<td>online change(4)(5)(7)</td>
<td>N</td>
</tr>
</tbody>
</table>

(1) Exceptions:
- forcing online
- changing the module association with a task
- In RUN, you cannot set a group of channels to "none" for a module that is declared in the Device DDT.

(2) A BM•CRA31210 (e)X80 performance adapter is required in a CCOTF transaction on an RIO drop.

(3) CCOTF cannot be performed for a digital module that has time stamping configured on one of its channels.

(4) The channel is not reset during parameter change. No channel task change.

(5) You cannot change task and event number parameters.

(6) You cannot add/delete an analog module with HART capability. You may change its configuration and parameters only.

(7) When you perform an online change in IODDT, %SW100 and %SW101 are not affected. You can modify module configuration parameters in online mode in IODDT.

(8) On a local rack, you cannot remove a digital input module that supports Run/Stop input (when selected) or Memory Protect input (when selected).

Legend:
- – irrelevant
- N: no available mechanism
### CCOTF Introduction

**NOTE:** CCOTF does not support the following:
- modules with topological I/O data type
- move a module in one modification
- add/delete an extended rack
- Premium modules
- unplug a TSXLYEX line terminator or BMXBC-•••K and TSXCBY-•••K cables

**NOTE:** CCOTF allows you to copy/paste a module. The new module has the parameter values of the copied module.

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Local Racks (Main or Extended)</th>
<th>RIO Drop</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Type (Vision) →</td>
<td>IODDT</td>
<td>Device DDT</td>
</tr>
<tr>
<td>modify time stamping</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>add equipment behind gateway</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>delete/modify equipment behind gateway</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>add/delete I/O or timer event section</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>modify I/O or timer event section</td>
<td>N</td>
<td>N</td>
</tr>
</tbody>
</table>

(1) Exceptions:
- forcing online
- changing the module association with a task
- In RUN, you cannot set a group of channels to "none" for a module that is declared in the Device DDT.

(2) A BM•CRA31210 (e)X80 performance adapter is required in a CCOTF transaction on an RIO drop.

(3) CCOTF cannot be performed for a digital module that has time stamping configured on one of its channels.

(4) The channel is not reset during parameter change. No channel task change.

(5) You cannot change task and event number parameters.

(6) You cannot add/delete an analog module with HART capability. You may change its configuration and parameters only.

(7) When you perform an online change in IODDT, %SW100 and %SW101 are not affected. You can modify module configuration parameters in online mode in IODDT.

(8) On a local rack, you cannot remove a digital input module that supports Run/Stop input (when selected) or Memory Protect input (when selected).

**Legend:**
- –: irrelevant
- N: no available mechanism
### Modules Supported in CCOTF

CCOTF supports these modules in RIO drops and main/extended local racks:

<table>
<thead>
<tr>
<th>Type of Module</th>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital</td>
<td>all X80 digital modules except BMXERT1604 (time stamp)</td>
</tr>
<tr>
<td>Analog</td>
<td>all X80 analog modules except BMEAH0+12 (HART)</td>
</tr>
<tr>
<td>Counting</td>
<td>–</td>
</tr>
<tr>
<td>Motion</td>
<td>–</td>
</tr>
<tr>
<td>Communication</td>
<td>–</td>
</tr>
</tbody>
</table>
CCOTF Parameters: What Can I Change?

Analog Input Module Parameters

**common:**
- channel used / not used
- channel range
- scale and overflow

**voltage/current:**
- filter efficiency (0 ... 6)
- normal / fast cycle (channel scan cycle (see Modicon X80, Analog Input/Output Modules, User Manual))

A typical configuration parameter screen looks like this:
temperature:
- cold junction compensation
- rejection 50 Hz / 60 Hz
- unit (celsius / fahrenheit)
- sensor monitor on / off (broken wire test)
- filter efficiency (0 ... 6)

Refer to the description of the %KW (see Modicon X80, Analog Input/Output Modules, User Manual) and scope of values (see Modicon X80, Analog Input/Output Modules, User Manual).

**Digital Module Parameters**
For all modules except BMX DRA **** (relay outputs of BMX DDM ****), each 8-channel group features:
- supply monitoring

The behavior of each digital output is configurable (see Modicon X80, Discrete Input/Output Modules, User Manual):
- fallback / maintain mode
- fallback value

BMX DDO ****, digital outputs of BMX DDM **** (except 16025) feature in addition:
- reactivate (auto / programmed rearm)

Refer to the description of the %KW (see Modicon X80, Discrete Input/Output Modules, User Manual).

**Analog Output Module Parameters**
For all modules:
- channel range
- scale
- overflow
- fallback / maintain mode (see Modicon X80, Analog Input/Output Modules, User Manual)
- fallback value
- actuator wiring control (wiring CTRL enabled / disabled)
- actuator alignment offset value (see Modicon X80, Analog Input/Output Modules, User Manual)

**Counting Module Parameters**
For each counter:
- function
- parameters in the Configuration tab
- parameters in the Adjust tab
Communication Module Parameters

**Access Control:** Enable (default) or disable Ethernet access to the multiple servers in the module from unauthorized network devices.

After you enable **Access Control**, you can add the IP addresses of the devices that you want the module to communicate with to the list of **Authorized Addresses**.

- By default, the IP addresses of the module’s I/O scanner service with **Subnet** set to **Yes** allows any device in the subnet to communicate with the module through EtherNet/IP or Modbus TCP.
- Add the IP address of any client device that may send a request to the module’s I/O scanner service, which, in this case, acts as an EtherNet/IP or Modbus TCP server.
- Add the IP address of your maintenance PC to communicate with the PAC through the module’s I/O scanner service via Control Expert to configure and diagnose your application.

**NOTE:**
- The subnet in the IP Address column can be the subnet itself or any IP address inside the subnet. If you select **Yes** for a subnet that does not have a subnet mask, a pop-up window states that the screen cannot be validated because of a detected error.
- You can enter a maximum of 127 authorized IP addresses or subnets.
CCOTF Counting and Status

CCOTF Counting Word
The system words %SW100 and %SW101 (see EcoStruxure™ Control Expert, System Bits and Words, Reference Manual) count the CCOTF modifications. The embedded rack viewer uses these words to retrieve the latest configuration in the CPU, and synchronizes the CPU and the EIO scanner service.

- %SW100 increments each time a CCOTF modification is performed on a local rack.
- %SW101 increments each time a CCOTF modification is performed on an RIO drop. A modification performed on a redundant Quantum S908 remote drop counts double therefore %SW101 increments twice.

NOTE: When a byte reaches its maximum value of 255, the counter resets to 1.

CCOTF Status Word
The CCOTF status word is %SW66 (see EcoStruxure™ Control Expert, System Bits and Words, Reference Manual).

The connection status of the added module is significant only when %SW66 does not indicate that CCOTF is in progress.

The %SW66 values sets the bits 1 and 2 in the CRA_DIAGNOSTIC word (see Modicon M580, RIO Modules, Installation and Configuration Guide).

Status Bits
The DDDT of the CPU scanner service and the BMENOC0301/11 Ethernet communication module contain the freshness bit (see Modicon M580, Hardware, Reference Manual).

Health bit storage:
- Local and RIO drop health bits are stored in the CPU/BMENOC0301/11 scanner service DDDT.
- Module health bits are stored in the BM•CRA312•0 EIO adapter DDT (one bit per module, up to 32 modules).

When you configure a module added to a local rack/RIO drop, the following bits are set to 0:
- health bit
- %S119 (see EcoStruxure™ Control Expert, System Bits and Words, Reference Manual), bit signaling a detected error in an I/O module on the local rack
- %S117 (see EcoStruxure™ Control Expert, System Bits and Words, Reference Manual), bit signaling a detected error in an I/O module on an RIO drop
- %S10 (see EcoStruxure™ Control Expert, System Bits and Words, Reference Manual), a global indicator

When a parameter is modified, the module is restarted, and the health bit is set to 0 during several ms. The bits %S10, %S117, and %S119 are set to 0.

NOTE: When adding, deleting, or modifying parameters in one module, the other modules available in the system are not impacted, and their status bits remain at 1.
Status Codes

Refer to the %SW66 topic (see EcoStruxure™ Control Expert, System Bits and Words, Reference Manual) for a list of processing status codes for local I/O and RIO.
Chapter 2
Prerequisites for M580 CCOTF

Overview
This chapter describes compatibility issues that require confirmation before you perform any CCOTF modification.

What Is in This Chapter?
This chapter contains the following topics:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCOTF Hardware Compatibility</td>
<td>30</td>
</tr>
<tr>
<td>CCOTF Hot Standby Guidelines</td>
<td>32</td>
</tr>
<tr>
<td>CCOTF Settings</td>
<td>35</td>
</tr>
</tbody>
</table>
CCOTF Hardware Compatibility

CPU Compatibility
You can use CCOTF with the following CPUs:
- BM-P581020
- BM-P5820xx
- BM-P5830xx
- BM-P5840xx
- BM-E58040
- BM-EH58040

NOTE: Use an M580 CPU version 2.00 (or later) to manage local I/O CCOTF features.

CRA Compatibility
You can use CCOTF to add the following EIO adapter modules:
- BMXCRA31210 X80 performance EIO adapter module
- BMECRA31210 eX80 performance EIO adapter module
- 140CRA31200 EIO adapter module (with a BM-E584040, BM-E585040, or BM-E586040 CPU)

Analog and Digital Module Compatibility
This table lists the I/O modules in RIO drops (with a BM-CRA312•0 (e)X80 EIO adapter module) that can be added / deleted / modified:

<table>
<thead>
<tr>
<th>Analog Modules</th>
<th>Digital Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMXAMI0410</td>
<td>BMXDAI0805</td>
</tr>
<tr>
<td>BMXAMI0800</td>
<td>BMXDAI0814</td>
</tr>
<tr>
<td>BMXAMI0810</td>
<td>BMXDAI1602</td>
</tr>
<tr>
<td>BMXART0414(1)</td>
<td>BMXDAI1603</td>
</tr>
<tr>
<td>BMXART0814</td>
<td>BMXDAI1604</td>
</tr>
<tr>
<td>BMXAMO0210</td>
<td>BMXDAO1605</td>
</tr>
<tr>
<td>BMXAMO0410</td>
<td></td>
</tr>
<tr>
<td>BMXAMO0802</td>
<td></td>
</tr>
<tr>
<td>BMXAMM0600</td>
<td></td>
</tr>
</tbody>
</table>

(1) Verify that a firmware V2.1 or later is installed.
Counting Module Compatibility

The counting modules whose configuration and adjustment can be modified are:

- BMXEHC0200
- BMXEHC0800
- BMXEHC0800.2
- BMXEAE0300
CCOTF Hot Standby Guidelines

Introduction

All BMEH58•040 Hot Standby CPUs support CCOTF. To enable CCOTF, in Control Expert, double-click the CPU in the PLC bus (or right-click Open Module), select the Configuration tab, and select the Online modification in RUN or STOP check box in the Configuration Online Modification area.

Hot Standby Guidelines

CCOTF allows modifications of a Hot Standby primary PAC configuration in RUN mode. The changes that can be made in the primary PAC are as follows:

- Add a discrete or analog module in a free slot.
- Delete a discrete or analog module.
- Modify the configuration and adjustment parameters of a module.

The changes that can be made in an Ethernet RIO drop are as follows:

- Add a Quantum or (e)X80 RIO drop.
- Add a discrete or analog module in a free slot.
- Delete a discrete or analog module.
- Modify the configuration and adjustment parameters of a module.

Any CCOTF changes made to the primary PAC configuration are not automatically transmitted to the standby PAC. Instead, the standby PAC continues to be configured with its original application program.

CCOTF does not support all changes to the configuration. The following rules apply to CCOTF changes made to the primary Hot Standby PAC configuration:

- A single CCOTF change can include multiple edits to multiple configuration objects.
- Edits to configuration objects are atomic: only one change can be made to a single configuration object. For example, you cannot add then delete the same I/O module in a single CCOTF change.
- CCOTF edits cannot be made to distributed equipment.
- For a Quantum or (e)X80 RIO drop, the following limits apply to changes made in the same CCOTF session:
  - Up to four modifications to the same RIO drop can be included in a single CCOTF change. For example:
    - Up to four I/O modules can be added to the same RIO drop.
    - Up to four ERT expert modules can be added to the same RIO drop.
    - Up to four I/O modules can be removed from the same RIO drop.
    - Up to four parameters can be edited for one I/O module in the same RIO drop.
  - No edits can be made to an (e)X80 RIO adapter module.
  - The RPI setting for the RIO drop cannot be changed.
- Only one CCOTF change may be made to a single RIO drop. Before an additional CCOTF change can be made to the same RIO drop, transfer the application program from the primary PAC to the standby PAC.
Prerequisites

Logic Mismatch

When CCOTF changes are made to the primary PAC, the Logic_Mismatch_Allowed flag in the T_M_ECPU_HSBY DDT determines if the standby PAC can continue to operate online. If logic mismatches are not allowed, the standby PAC transitions to wait state.

Maximum Number of Modifications

CCOTF changes can be made to the primary PAC if the Number of modifications setting in Control Expert is not reached. When the number of allowed modifications are reached:

- No additional CCOTF changes can be made to the primary PAC. The Build → Build Changes command in Control Expert is disabled.
- Transfer the application program in the primary PAC to the standby PAC (see Modicon M580 Hot Standby, System Planning Guide for, Frequently Used Architectures).

Refer to the Modicon M580 Hot Standby System Planning Guide (see Modicon M580 Hot Standby, System Planning Guide for, Frequently Used Architectures) for detailed information on the BME H58 •040 Hot Standby CPUs.

Modification Limitations

For a Quantum ERIO drop, you can perform a maximum of four modifications per CCOTF session. After a successful build change, four new modifications are again possible. This limit of four modifications is managed in the CCOTF operating modes. However, a CCOTF action for a Quantum ERIO drop is possible only when there is available memory.

This table shows the number of possible CCOTF actions for a Quantum ERIO drop:

<table>
<thead>
<tr>
<th>Action</th>
<th>Object</th>
<th>Actions per Transaction</th>
<th>Limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td>add</td>
<td>ERIO drop</td>
<td>1</td>
<td>—</td>
</tr>
<tr>
<td>add</td>
<td>ERIO module</td>
<td>4</td>
<td>—</td>
</tr>
<tr>
<td>add</td>
<td>ERIO ERT module</td>
<td>4</td>
<td>—</td>
</tr>
<tr>
<td>modify parameter</td>
<td>ERIO drop - RPI</td>
<td>0</td>
<td>not supported</td>
</tr>
<tr>
<td>modify parameter</td>
<td>ERIO module configuration</td>
<td>1 (See note.)</td>
<td>not supported</td>
</tr>
<tr>
<td>modify</td>
<td>ERIO module - CRA</td>
<td>0</td>
<td>not supported</td>
</tr>
<tr>
<td>modify</td>
<td>ERIO module - CRP</td>
<td>0</td>
<td>not supported</td>
</tr>
<tr>
<td>remove</td>
<td>ERIO module</td>
<td>4</td>
<td>—</td>
</tr>
</tbody>
</table>

**NOTE:** Even if the user changes up to four parameters on one module, the system counts one modification.
For (e)X80 modules, the CCOTF limitations are unchanged.

Quantum ERIO modules that are configured with an M580 PAC have these limitations:
- You can add an online Quantum ERIO drop only for M580 standalone and M580 Hot Standby CPUs.
- You can add or remove only discrete and analog Quantum I/O modules.
- You can add or remove these expert modules:
  - 140ERT85410
  - 140ERT85420
  - 140ERT85430
- You cannot add or remove these modules:
  - GENANAIO
  - 140NRP31200
  - 140NRP31201
  - 140XBE10000
  - 140EHC10500
  - 140EHC20200
  - GENIO
  - 140ESI06210
CCOTF Settings

CPU Configuration Screen

To allow CCOTF, access the CPU configuration screen in Control Expert, and select the **Online modification in RUN or STOP** check box:

![CPU Configuration Screen](image)

Watchdog Values

Set the watchdog timer of each task to the minimum value of 64 ms.

To set the values, refer to Displaying and Modifying Task Properties *(see EcoStruxure™ Control Expert, Operating Modes)*.
Part II
How to Perform an M580 CCOTF Modification

Introduction
This part describes how to add / delete RIO drops, add / delete modules in an RIO drop, and modify module parameters via CCOTF modifications.

What Is in This Part?
This part contains the following chapters:

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Chapter Name</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Adding an RIO Drop using CCOTF</td>
<td>39</td>
</tr>
<tr>
<td>4</td>
<td>Adding / Deleting Modules in Local Racks and RIO Drops Using CCOTF</td>
<td>45</td>
</tr>
<tr>
<td>5</td>
<td>Modifying Module Parameters</td>
<td>57</td>
</tr>
</tbody>
</table>
Chapter 3
Adding an RIO Drop using CCOTF

Introduction
This chapter describes how to add an RIO drop using the standard or virtual mode. When you add an RIO drop to a running system, the cycle time and bandwidth usage may increase.

NOTE: Confirm that the RIO drop you are adding contains only non-configured modules or modules configured with the MAST task.

What Is in This Chapter?
This chapter contains the following topics:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding an RIO Drop Using the Standard Connected Mode</td>
<td>40</td>
</tr>
<tr>
<td>Adding an RIO Drop Using the Virtual Connected Mode</td>
<td>42</td>
</tr>
</tbody>
</table>
Adding an RIO Drop Using the Standard Connected Mode

Introduction

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>UNINTENDED EQUIPMENT OPERATION</strong></td>
</tr>
<tr>
<td>● Verify that the margin between watchdog timers and task execution times is great enough to handle the increased processing time required to support the CCOTF modification.</td>
</tr>
<tr>
<td>● Anticipate performance decrease due to the increased traffic resulting from the new RIO drop in the system.</td>
</tr>
<tr>
<td>Failure to follow these instructions can result in equipment damage.</td>
</tr>
</tbody>
</table>
Adding an RIO Drop

This describes the process of adding an RIO drop using the standard connected mode:

1. Connect Control Expert to the PAC.
2. Add the drop in the Control Expert configuration screen of the remote I/O network.
3. Add the modules in the remote I/O drop.
4. If necessary, modify the parameters or mapping in the module configuration screen.
5. Select the Build Changes menu item.
   **NOTE:** The drop configuration screen indicates a detected error for the new modules. For an MX80 drop, the device DDT memory area is cleared.
6. Install the drop in the remote I/O network.
   **NOTE:** The input module memory image is refreshed with default values.
7. Add the code sequence to manage the new drop and modules in the application program.
8. Select the Build Changes menu item.
   **NOTE:** In output modules, verify that all output bits are well-managed via the LED display of the module.
9. Connect field-wiring terminal strip on modules.
   **NOTE:** The input memory image is set with physical values.
10. Test that the modifications have been accounted for correctly.

Modify the application, and select the Build Changes menu item.

**NOTE:** An RIO drop contains 1 or 2 racks (linked with a backplane expander cable).
Adding an RIO Drop Using the Virtual Connected Mode

Introduction

To switch to virtual connected mode, select Tools → Project settings → General → Build settings in Control Expert, and select the Virtual connected mode check box.

When you add an RIO drop to a running system, the cycle time and bandwidth usage may increase.

### NOTICE

<table>
<thead>
<tr>
<th>UNINTENDED EQUIPMENT OPERATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Verify that the margin between watchdog timers and task execution times is great enough to handle the increased processing time required to support the CCOTF modification.</td>
</tr>
<tr>
<td>- Anticipate performance decrease due to the increased traffic resulting from the new RIO drop in the system.</td>
</tr>
</tbody>
</table>

Failure to follow these instructions can result in equipment damage.

Two stages are required in the virtual connected mode:
- The Offline stage is the preparation in Control Expert.
- The Online stage is the physical action and downloading to the PAC.

Stage 1: Adding an RIO Drop in Offline Mode

This describes the process of adding an RIO drop using the virtual connected, offline mode:

1. Add the remote I/O drop.
2. Add the remote I/O drop in the Control Expert configuration screen of the remote I/O bus.
3. Add the modules in the remote I/O drop.
4. If necessary, modify the parameters or mapping in the modules configuration screen.
5. Add the code sequence in the application to manage the new remote I/O drop and its modules.
6. Save the application.

**NOTE:** An RIO drop contains 1 or 2 racks (linked with a cable).
Stage 2: Adding an RIO Drop in Online Mode

This describes the process of adding an RIO drop in the virtual connected, online mode when Control Expert is connected to the PAC:

1. Open the application.
2. Connect Control Expert to the PAC.
3. Press the **Build Changes** button. The set of modifications is transferred to the CPU. **NOTE:** The new modules indicate an error condition in the configuration screen of the remote I/O drop. For an X80 drop, the device DDT memory area is cleared.
4. Install the remote I/O drop with modules in the remote I/O network. **NOTE:** The input module memory image is refreshed with default values.
5. Connect the terminal block or connector on modules. **NOTE:** The input memory image in device DDT is set with physical values.
6. Test that the modifications have been accounted for correctly.
   - **Test**
   - **OK**
   - **END**
   - **Not OK**
   - Modify the application and press the **Build Changes** button.
Chapter 4

Adding / Deleting Modules in Local Racks and RIO Drops Using CCOTF

Introduction

This chapter describes how to add / delete a module in local racks and RIO drops (using the standard or virtual mode). When you add / delete a module in a running system, the cycle time and bandwidth usage may increase.

What Is in This Chapter?

This chapter contains the following topics:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding/Deleting a Module in a Local Rack</td>
<td>46</td>
</tr>
<tr>
<td>Adding/Deleting a Module in an RIO Drop Using the Standard Connected Mode</td>
<td>50</td>
</tr>
<tr>
<td>Adding/Deleting a Module in an RIO Drop Using the Virtual Connected Mode</td>
<td>54</td>
</tr>
</tbody>
</table>
Adding/Deleting a Module in a Local Rack

Adding a Module in a Local Rack

**NOTICE**

**UNINTENDED EQUIPMENT OPERATION**
- Verify that the margin between watchdog timers and task execution times is great enough to handle the increased processing time required to support adding a new module.
- Confirm that the watchdog values of all modules in local and extended racks are greater than the time needed to perform CCOTF.
  
  **Example:**
  - For a MAST task with a watchdog value of 60 ms, the module watchdog is 256 ms.
  - For a MAST task with a watchdog value of 20 ms, the module watchdog is 32 ms.
- Anticipate performance decrease due to the increased traffic if you add a new module to the system.

Failure to follow these instructions can result in equipment damage.

**NOTE:** Use an M580 CPU version 2.00 (or later) to manage local I/O CCOTF features.

**NOTE:** During a CCOTF transaction on the local rack, MAST / FAST / AUX / IO Event section / Timer Event section are performed at the end of the CCOTF transaction. If several IO Timer event sections occur during a CCOTF transaction, the sections are performed once only at the end of the CCOTF transaction.
This describes the process of adding a module to a main or extended local rack:

1. Connect Control Expert to the PAC.
2. Add the module in the Control Expert configuration screen.
3. If necessary, modify the parameters or mapping in the module configuration screen.
4. Press the **Build Changes** button. Using the module contextual menu, check the power supply.
   **NOTE:** The PAC detects a module error. The PAC application image memory contains initial values. The detected channel errors are set.
5. Install the module in the rack without terminal block or connector.
   **NOTE:** The PAC configures the module, and the application memory is updated with values coming from the module. When communication with the PAC is established, RUN turns on, and ERR changes from flashing to off. I/O flashes or remains steady on. The PAC ERR LED is steady on.
6. Add the code sequence in the application to include the new module.
7. Press the **Build Changes** button.
   In the digital output modules, verify via the LEDs that all output bits are well set regarding the process.
8. Insert the terminal block or connector into module.
   **NOTE:** The outputs are set to physical values and module I/O LED turns off.
9. Check that no errors are detected in the application. Check the input/output connection as described in your System Installation Guide.

![Diagram of the process flow]

**Test**
- **OK**
- **END**

**Modify the application and press the **Build Changes** button.**
Deleting a Module from a Local Rack

⚠️ WARNING

POSSIBLE UNEXPECTED EQUIPMENT BEHAVIOR
- Check that deleting the module does or does not have impact on the process or on the application execution.
- For input modules, consider that the input values in the memory image may be forced.
- Remove the terminal block or connector from the module before deleting a module.
- Account for overhead time linked with the CCOTF process for watchdog management. (See the previous Notice (see page 46).)

Failure to follow these instructions can result in death, serious injury, or equipment damage.

⚠️ WARNING

UNINTENDED EQUIPMENT OPERATION
- Do not use a DDDT that is associated with a module that you remove from a local or remote rack.
- When you remove the module, the associated DDDT becomes unmanaged and cannot be used in the application.

Failure to follow these instructions can result in death, serious injury, or equipment damage.
This describes the process of deleting a module from a main or extended local rack:

1. Connect Control Expert to the PAC.
2. Disconnect the terminal block or connector from the module.
3. Delete the code sequence related to this module in the application.
4. Press the **Build Changes** button.
5. Uninstall the module from the rack. **NOTE:** The configuration screen detects a module error condition (red square).
6. Delete the module in the Control Expert configuration screen.
7. Press the **Build Changes** button.
8. Test that the modifications have been accounted for correctly.

   - If **Test** is **OK**, **END**.
   - If **Test** is **Not OK**, modify the application and press the **Build Changes** button.
Adding / Deleting a Module in an RIO Drop Using the Standard Connected Mode

Adding a Module in an RIO Drop

**NOTICE**

UNINTENDED EQUIPMENT OPERATION

- Verify that the margin between watchdog timers and task execution times is great enough to handle the increased processing time required to support adding a new module.
- Anticipate performance decrease due to the increased traffic if you add a new module to the system.

*Failure to follow these instructions can result in equipment damage.*
This describes the process of adding a module to an RIO drop using the **standard connected mode**:

1. Connect Control Expert to the PAC.
2. Add the module in the Control Expert configuration screen.
3. If necessary, modify the parameters or mapping in the module configuration screen.
4. Press the **Build Changes** button. Using the module contextual menu, check the power supply. **NOTE:** The PAC detects a module error. The PAC application image memory contains initial values. The detected channel errors are set.
5. Install the module in the rack without terminal block or connector. **NOTE:** The BMX/BME CRA Adapter configures the module, and the application memory receives the module values. When the communication with the CRA is established, RUN turns on and ERR turns off. I/O is blinking or steady on CRA: ERR LED is steady on.
6. Add the code sequence in the application to include the new module.
7. Press the **Build Changes** button. In the digital output modules, verify via the LEDs that all output bits are well set regarding the process.
8. Insert the terminal block or connector into module. **NOTE:** The outputs are set to physical values and module I/O LED turns off. CRA: ERR turns off if there is no detected error.
9. Check that no errors are detected in the application. Check the input/output connection as described in your **System Installation Guide**.

Modify the application and press the **Build Changes** button.
Deleting a Module from an RIO Drop

⚠️ WARNING

POSSIBLE UNEXPECTED EQUIPMENT BEHAVIOR

- Confirm whether the deletion of the module does or does not have impact on the process or on the application execution.
- For input modules, consider that the input values in the memory image may be forced.
- Remove the terminal block or connector from the module before deleting a module.

Failure to follow these instructions can result in death, serious injury, or equipment damage.

⚠️ WARNING

UNINTENDED EQUIPMENT OPERATION

- Do not use a DDDT that is associated with a module that you remove from a local or remote rack.
- When you remove the module, the associated DDDT becomes unmanaged and cannot be used in the application.

Failure to follow these instructions can result in death, serious injury, or equipment damage.
Adding / Deleting Modules

This describes the process of deleting a module from an RIO drop using the standard connected mode:

1. Connect Control Expert to the PAC.
2. Disconnect the terminal block or connector from the module.
3. Delete the code sequence related to this module in the application.
4. Press the Build Changes button.
5. Uninstall the module from the rack.
   **NOTE:** The configuration screen detects a module error condition (red square).
6. Delete the module in the Control Expert configuration screen.
7. Press the Build Changes button.
8. Test that the modifications have been accounted for correctly.

   **Test**
   
<table>
<thead>
<tr>
<th>OK</th>
<th>Not OK</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>END</td>
<td></td>
</tr>
</tbody>
</table>

Modify the application and press the Build Changes button.
Adding / Deleting a Module in an RIO Drop Using the Virtual Connected Mode

Prerequisite

To switch to virtual connected mode, click Tools → Project settings → General → Build settings from the main menu, and select the Virtual connected mode check box.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>UNINTENDED EQUIPMENT OPERATION</strong></td>
</tr>
<tr>
<td>● Verify that the margin between watchdog timers and task execution times is great enough to handle the increased processing time required to support the addition of a new module.</td>
</tr>
<tr>
<td>● Anticipate performance decrease due to the increased traffic if you add a new module to the system.</td>
</tr>
<tr>
<td>Failure to follow these instructions can result in equipment damage.</td>
</tr>
</tbody>
</table>

Two stages are required in the virtual connected mode:

● The **Offline** stage is the preparation in Control Expert.

● The **Online** stage is the physical action and downloading to the PAC.
**Stage 1: Adding / Deleting a Module in an RIO Drop in Offline Mode**

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>UNINTENDED EQUIPMENT OPERATION</strong></td>
</tr>
<tr>
<td>• Do not use a DDDT that is associated with a module that you remove from a local or remote rack.</td>
</tr>
<tr>
<td>• When you remove the module, the associated DDDT becomes unmanaged and cannot be used in the application.</td>
</tr>
<tr>
<td><strong>Failure to follow these instructions can result in death, serious injury, or equipment damage.</strong></td>
</tr>
</tbody>
</table>

This describes the process using the virtual connected, offline mode:

**Adding a module**

- Add the module in the Control Expert rack configuration screen.
- If necessary, modify the parameters or mapping in the module configuration screen.
- Add the code sequence to include the module in the application.
- Save the application.

**Deleting a module**

- Delete the code sequence related to this module in the application.
- Delete the module in the Control Expert Rack configuration screen.

**Stage 2: Adding / Deleting a Module from an RIO Drop in Online Mode**

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>UNINTENDED EQUIPMENT OPERATION</strong></td>
</tr>
<tr>
<td>• Do not use a DDDT that is associated with a module that you remove from a local or remote rack.</td>
</tr>
<tr>
<td>• When you remove the module, the associated DDDT becomes unmanaged and cannot be used in the application.</td>
</tr>
<tr>
<td><strong>Failure to follow these instructions can result in death, serious injury, or equipment damage.</strong></td>
</tr>
</tbody>
</table>
Adding / Deleting Modules

This describes the process using the virtual connected, online mode, when Control Expert is connected to the PAC:

1. Open the application.
2. Connect Control Expert to the PAC. The Build Changes menu item is now available.
3. **Adding a module**
   - Press the Build Changes button; this transfers the modifications to the CPU. Using the module contextual menu, check the power supply.
   - Install the module in the rack without terminal block or connector.
   - **NOTE**: The BMX/BME CRA configures the module and the application memory receives the module values. When the communication is established, RUN turns on, and ERR turns off. I/O is blinking or steady on. CRA: ERR is steady on.
   - In the digital output modules, verify via the LEDs that all output bits are well set.
   - Insert the terminal block or connector into the module.
   - **NOTE**: The outputs are set to physical values. Module I/O LED turns off. CRA: ERR turns off if no errors are detected.
   - Verify that there are no detected errors remaining in the application. Check the input/output connection as described in your Installation Guide.
4. **Deleting a module**
   - Disconnect the terminal block or connector from the module.
   - Press the Build Changes button; this transfers the modifications to the CPU.
   - Uninstall the module from the rack. The configuration screen indicates a detected error condition (red square).
   - Modify the application and press the Build Changes button.

\[ EIO0000001590 12/2018 \]
Chapter 5
Modifying Module Parameters

Overview
This chapter describes the various procedures to modify the module parameter values.

What Is in This Chapter?
This chapter contains the following topics:

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modifying Module Parameters Using the Standard Connected Mode</td>
<td>58</td>
</tr>
<tr>
<td>Modifying Module Parameters Using the Virtual Connected Mode</td>
<td>59</td>
</tr>
</tbody>
</table>
Modifying Module Parameters Using the Standard Connected Mode

Parameter Modifications

Modifications made when the Online modification in RUN or STOP check box is selected have an immediate impact on the process.

**NOTE:** Use an M580 CPU version 2.00 (or later) to manage local I/O CCOTF features.

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>UNINTENDED EQUIPMENT OPERATION</strong></td>
</tr>
<tr>
<td>• Check that modifying the module parameters does or does not have impact on the process or on the application execution.</td>
</tr>
<tr>
<td>• For input modules, consider that the input values in the memory image may be forced.</td>
</tr>
<tr>
<td>• Remove the terminal block or connector from the module before modifying the module parameters.</td>
</tr>
<tr>
<td>• Account for overhead time linked with the CCOTF process for watchdog management. (See the previous Notice (see page 46).)</td>
</tr>
<tr>
<td><strong>Failure to follow these instructions can result in death, serious injury, or equipment damage.</strong></td>
</tr>
</tbody>
</table>

This describes the process of modifying module parameters *(see page 23)* using the **standard connected mode**:

1. Connect Control Expert to the PAC.
2. Select Project > Configuration > xxx Bus from the main menu.
3. Modify the module parameters.
4. Validate the modification, and press the Build Changes button.
5. Test that the modifications have been accounted for correctly.
6. Modify the application, and press the Build Changes button.

**END**
Modifying Module Parameters Using the Virtual Connected Mode

Prerequisite

![WARNING]

UNINTENDED EQUIPMENT OPERATION
- Check that modifying the module parameters does or does not have impact on the process or on the application execution.
- For input modules, consider that the input values in the memory image may be forced.
- Remove the terminal block or connector from the module before modifying the module parameters.
- Account for overhead time linked with the CCOTF process for watchdog management. (See the previous Notice (see page 46).)

Failure to follow these instructions can result in death, serious injury, or equipment damage.

To switch to virtual connected mode, click **Tools → Project settings → General → Build settings** and select the **Virtual connected mode** check box.

Modifications made when the **Online modification in RUN or STOP** check box is selected can have an immediate impact on the process.

**NOTE:** Use an M580 CPU version 2.00 (or later) to manage local I/O CCOTF features.

Stage 1: Modifying Parameters in Offline Mode

This describes the process using the **virtual connected, offline** mode:

Select **Project → Configuration → xxx Bus** from the main menu, and double click the module.

- Modify the module parameters.
- Validate the modification.
- Save the application.
Stage 2: Modifying Parameters in Online Mode

This describes the process using the virtual connected, online mode, when Control Expert is connected to the PAC:

1. Open the application.
2. Connect Control Expert to the PAC. The Build Changes button is now available.
3. Press the Build Changes button.
4. Test that the modifications have been accounted for correctly.
5. Modify the application, and press the Build Changes button.
6. Test
   - OK
   - Not OK

END
Glossary

A

AUX
An (AUX) task is an optional, periodic processor task that is run through its programming software. The AUX task is used to execute a part of the application requiring a low priority. This task is executed only if the MAST and FAST tasks have nothing to execute. The AUX task has two sections:
- IN: Inputs are copied to the IN section before execution of the AUX task.
- OUT: Outputs are copied to the OUT section after execution of the AUX task.

C

CCOTF
(change configuration on the fly) A feature of Control Expert that allows a module hardware change in the system configuration while the system is operating. This change does not impact active operations.

D

DDT
(derived data type) A derived data type is a set of elements with the same type (ARRAY) or with different types (structure).

Device DDT (DDDT)
A Device DDT is a DDT predefined by the manufacturer and not modifiable by user. It contains the I/O language elements of an I/O module.

F

FAST
A FAST task is an optional, periodic processor task that identifies high priority, multiple scan requests, which is run through its programming software. A FAST task can schedule selected I/O modules to have their logic solved more than once per scan. The FAST task has two sections:
- IN: Inputs are copied to the IN section before execution of the FAST task.
- OUT: Outputs are copied to the OUT section after execution of the FAST task.
Hot Standby
A Hot Standby system uses a primary PAC (PLC) and a standby PAC. The two PAC racks have identical hardware and software configurations. The standby PAC monitors the current system status of the primary PAC. If the primary PAC becomes inoperable, high-availability control is maintained when the standby PAC takes control of the system.

IODDT
(input/output derived data type) A structured data type representing a module, or a channel of a CPU. Each application expert module possesses its own IODDTs.

local rack
An M580 rack containing the CPU and a power supply. A local rack consists of one or two racks: the main rack and the extended rack, which belongs to the same family as the main rack. The extended rack is optional.

MAST
A master (MAST) task is a deterministic processor task that is run through its programming software. The MAST task schedules the RIO module logic to be solved in every I/O scan. The MAST task has two sections:
- **IN**: Inputs are copied to the IN section before execution of the MAST task.
- **OUT**: Outputs are copied to the OUT section after execution of the MAST task.

PAC
programmable automation controller. The PAC is the brain of an industrial manufacturing process. It automates a process as opposed to relay control systems. PACs are computers suited to survive the harsh conditions of an industrial environment.
RIO drop
One of the three types of RIO modules in an Ethernet RIO network. An RIO drop is an M580 rack of I/O modules that are connected to an Ethernet RIO network and managed by an Ethernet RIO adapter module. A drop can be a single rack or a main rack with an extended rack.

RPI
(requested packet interval) The time period between cyclic data transmissions requested by the scanner. EtherNet/IP devices publish data at the rate specified by the RPI assigned to them by the scanner, and they receive message requests from the scanner at each RPI.
Index

D
DDT
  Logic_Mismatch_Allowed, 32
  T_M_ECPU_HSBY, 32

H
Hot Standby, 32

L
Logic_Mismatch_Allowed, 32

T
T_M_ECPU_HSBY, 32